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Using Power BI 

ETL software is used to automate the redundant manipulation of data. In this exercise 
you will use Power BI to: 
 

Extract the Data file(s) from Excel 

Transform the data 

Load the transformed data into Excel 
The sales data for Cuddly Stuffed Animals are stored in an Excel sheet titled January 
Sales Data. The column headings are in the ninth row, some rows have partial duplicate 
data and some rows are blank. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
t 
 
 

 
Note: You cannot extract data from an open 
Excel file so make sure that the Excel file is 
closed before starting to input the data. 

  

Sample Report 
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Start Power BI Desktop 

Operation 1: Get Data – Input Excel file 

Select “Get Data” from the “External data” group under the “Home” tab. 
 

 
 
Select “Excel”. 
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Select the file. 
 
 
 
 
 
 
 
Select “Open”. 
 
 
 
 
 
 
 
 

 
Highlighting the desired sheet does not activate the Load and Edit buttons. 
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Double click on “January Sales Data” or you can select the check box on the left of 
“January Sales Data”.  
 

The data preview will be displayed. 
 
 
 
 
 
 
Select “Transform Data” or “Edit” and a new window called Power Query Editor opens. 
 
 
 
 
 
 
In the Power Query window, Power BI Desktop records each data modifications in the 
“Applied Steps” section.  
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The program added the steps 
that it performed as Power BI 
inputted the data.  Note that it 
did not correctly find the row 
that contains the “Headers”.  
Therefore, some steps must be 
deleted. 
 
 
Select the step, “Changed Type”.  
 
 
Right click and select “Delete”. 
 
 
 
 
 
 
Delete the step “Promoted 
Headers”, leaving us with 
two steps. 
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Operation 2: Fix the Headers – The field headers are in the third row of the source 
document.  Remove the top two rows to move the headers to the first row and then 
promote them to the Query Editors’ headers.  
 

 
 
 
 

 
 
 
Select “Remove Rows”. 
 
 
Select “Remove Top Rows”. 
 
 
Enter a “2” to remove top three rows.  
 
 
 
 
 
 
Then click “OK”. 
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To promote the first row in the current data to Query Editors’ headers, select “Use First 
Row as Headers”. 
 

 
 
 
 

 
 
 
 
 
Note: After you perform a transformation, the changes 
are recoded in the “Applied Steps” section. If you 
incorrectly did a step, you can easily delete the step 
and do it again. 
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Operation 3: Filter Rows – Exclude rows that do not contain Sales Order Number 
You can observe that there are several rows that do not contain a sales order number. 
We can add a filter step which will remove such rows. Note that we are not deleting 
anything from the source data file. This will just filter such data out and exclude these 
records from the final table.  
 
Click on the “drop-down” next to “Sales Order #”, Uncheck “null” and Click “OK”. 

 
 
 
Notice that “Filtered Rows” step is automatically 
added on the right side in the “Applied Steps” 
section. 
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The Data in the Fields Must Conform to Predefined Rules. 
 
In the original Excel file, The Cuddly Stuffed Animals company provided the only 
acceptable values for “Product”, “Salesperson” and “Region”.  Sometime data is entered 
incorrectly into the data. 
 
 
 
 
 
 
 
 
 
Operation 4 :–  Verify that the Salesperson field is correct 
 
Click on the “drop-down” next to “Salesperson”. 
 
The “Salesperson” field can only contain one of the six salespersons.  Browse the data 
in the “Salesperson” field to verify that all the data is correct.  Make any changes that 
are required.  
 
 
“Thomass” must be 
replaced with “Thomas”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select Cancel.  
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Select Replace Values 
 
 
 
 
 
 
 
 
 
Value to find “Thomass” 
Replace with “Thomas” 
 
Select OK. 
 
Click on the “drop-down” next to “Salesperson”. 
 
 
 
 
 
 
 
 
 
 
Select Cancel.  
 
 
 
 
 
A step has been added to the Applied Steps. 
 
 
 
 
 
 
  



CSA Power BI The First Stream    Mark Friedman 
  University of Miami 

11 
 

Operation 5 :–  Verify that the Product field is correct 
 
Click on the “drop-down” next to “Region”. 
 

The “Region” field can only contain one of the six 
products.  Browse the data in the “Region” field to verify 
that all the data is correct.  Make any changes that are 
required. 
 
 
 
 
 

 

 
 
 
No changes must be made, select Cancel. 
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Operation 6 :–  Verify that the Product field is correct 
 
Click on the “drop-down” next to “Product”. 
 
The “Product” field can only contain one of the six 
products.  Browse the data in the “Product” field to verify 
that all the data is correct.  Make any changes that are 
required. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No changes must be made, select Cancel. 
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Operation 7: Change the data type.   Change the type of all numeric fields that will be 
used in calculations to “Fixed Decimal”. The “# of units should have zero decimal places 
and dollar values should have two decimal places. 
 
Click on the  in the left-hand corner of 
the field “Sales”. 
 
Select “$ Fixed decimal number”.  
 
Do the same to the “Profit Margin” Field. 
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Operation 8: Load data. Click on “Close and Apply” 

This loads the data onto Power BI from Power Query 
Editor. 

 

 

 

 

Now you’ll be back to the main window of Power BI. 
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Operation 9: Create a “Table”. 
Click on the Table icon under the Visualization section to add a table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the dots to the right of “January Sales Data”. 
 
 
 
 
Select “Expand all”. 
 
The order that you select the fields is used to determine the order in which the fields are 
displayed in the table. Click on the box next to each field in the order that you want the 
fields to be displayed.  

1. Product 
2. # of units 
3. Sales 
4. Profit Margin 
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Operation 10: Exporting data to Excel 
Select the table and 
notice that you get More 
Options indicated by 3 
dots (…) on the top or 
bottom right of the table. 

 

 

 

Click on the More 
Options  

 

 

 

Select “Export Data”. 

 

 

 

 

Type the name of the file “Report by Product.csv”. 

 

 

 

 

 

 

Select Save. 
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Open the original excel file  

Select the file. 
 
 
 
 
Select “Open”. 
 
 
 
 
 

To open the new report, navigate in file manager and double click on the “Report by 
Product.csv” file.  

 

 

 

 

 

Copy this tab to the original Excel by right clicking 
on the tab Report by Product and selecting “Move 
or Copy”.  
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Select the name of the original file.  

 

 

 

Then click “OK”. 

Scroll till the end and click on “(move to end)”. 

 

Then click “OK”. 

 

 

 

Rename the tab as “January Report by Product”. Add totals, format the sheet, save and 
close the Excel file. 
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Operation 11: Save the “Flow and Data”  

Select “File” > “Save as”. 

 

Type the name of the file. 

 
 

Select Save. 
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Part 2 
 

The “February-December Sales Data” tab contains data that was created in a different 
system than the “January Sales Data”. You cannot append two data sets unless the 
field names and field types are identical.  The fields, however, may be ordered 
differently.  
 
January Sales Data 

 
February-December Sales Data 

 
 
As you review the new sheet note the differences: 

0. The column headings are in row 4. 
1. The column headings are different. 
2. The columns are in a different order. 
3. Column B contains both the Salesperson’s number and name. 
4. Selling Price Per Units has replaced Sales. 
 

Sample Report 
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Operation 12: Get Data – Input Second Data Set From 

Select “Get Data” from the External Data Group Under Home tab. 
 

 
 
Select “Excel”. 
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Select the file. 
 
 
 
 
 
 
 
Select “Open”. 
 
 
 
 
 
 
 
 

 

  
Highlighting the desired sheet does not activate the Load and Edit buttons. 
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Double click on “February-December Sales Data” or you can select the check box on 
the left of “February-December Sales Data”.  

 
The data preview will be displayed. 
 
 
 
 
 
 
Select “Transform Data” or “Edit” and a new window called Power Query Editor opens. 
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Now there are two queries.  
 

 
 
The program added the steps 
that it performed as Power BI 
inputted the data.  Note that it 
did not correctly find the row 
that contains the “Headers”.  
Therefore, some steps must be 
deleted. 
 
 
Select the step, “Changed Type”.  
 
 
Right click and select “Delete”. 
 
 
 
 
 
 
Delete the step “Promoted 
Headers”, leaving us with 
two steps. 
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Operation 13: Fix the Headers – The field headers are in the third row of the source 
document.  Remove the top two rows to move the headers to the first row and then 
promote them to the Query Editors’ headers.  

 
 
 
Select “Remove Rows”. 

 
 
Select “Remove Top Rows”. 
 
 
Enter a “2” to remove top three rows.  
 
 
 
 
 
 
Then click “OK”. 
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To promote the first row in the current data to Query Editors’ headers, select “Use First 
Row as Headers”. 
 

 
 
 

 
 
 
 
 
 
Note: After you perform a transformation, the changes 
are recoded in the “Applied Steps” section. If you 
incorrectly did a step, you could easily delete the step 
and do it again. 
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Operation 14: Filter Rows – Exclude rows that do not contain Sales Order Number 
You can observe that there are several rows that do not contain a “Title”. Add a filter 
step which will remove such rows. Note that we are not deleting anything from the 
source data file. This will just filter such data out and exclude these records from the 
final table.  
 
Click on the “drop-down” next to “Title”, Uncheck “null” and Click “OK” 

  
 
 
Notice that “Filtered Rows” step is automatically 
added on the right side in the “Applied Steps” 
section. 
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Before we append the “February-December Sales Data” set to the “January Sales Data” 
set the “Field Names” and “Types” must be identical. 
 
There are ten fields in the “February-December Sales Data” stream, and we will review 
them one by one making all necessary changes. 
 
January Query

 
 

 
 
 
February-December Query 
 1 2 3 4 5 6 

 
 
 7 8 9 10 

 
 
1) The field “Sales Order #” has no changes. 
2) The field  “Salesperson” is a merged field of the “Salesperson #” 

field and the “Salesperson” field. They are separated by a colon. 
The colon is referred to as a delimiter. Common delimiters are 
colons, commas, dashes, and semicolons. 
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Operation 15: Split Column – Separate One Column into Many Columns 
 

 

Select the column “Salesperson”. 

 

 

 

 

 

Select “Split Column”. 

 

 

 

Select “By Delimiter”. 
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Select “Colon”. 

 

 

 

 

Verify that “Each occurrence of the 
Delimiter” is selected. 

 

 

 

Click “OK”. 

 

Two new fields are created from parsing the “Salesperson” field. 
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Operation 16: Rename Columns  

 
To rename the column heading double click on “SalesPerson.1”. 
 

 
Type “Salesperson #” and press enter.  
 

 
 
In the same way rename “SalesPerson.2” to “Salesperson”.  
 
 

 
 
After the split the field “SalesPerson” may have extra spaces. To trim the field and 
remove extra spaces from the beginning and ending of a string right click on 
“SalesPerson”. 
 
 
 
 
 
Select “Transform”. 
 
 
Select “Trim”. 
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Click on the “drop-down” next to “Salesperson”. 
 
The “Salesperson” field can only contain one of the six 
salespersons.  Browse the data in the “Salesperson” field to 
verify that all the data is correct.  Make any changes that 
are required. 
 
 
 
 

 
 
“Thomass” must be replaced with 
“Thomas”. 
 
 
 
 
 
 
 
 
 
 
 
 
Select Cancel.  
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Select Replace Values 
 
 
 
 
 
 
 
 
 
Value to find “Thomass” 
Replace with “Thomas” 
 
Select OK. 
 
Click on the “drop-down” next to “Salesperson”. 
 
 
 
 
 
 
 
 
 
 
Select Cancel.  
 
 
 
 
 
3) The field “Title” has no changes. 
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4) The field “Region” has no changes, we must verify that all the names have been 
entered correctly. 

 
The “Region” field can only contain one of the four regions.  Browse 
the data in the “Region” field to verify that all the data is correct.  
Make any changes that are required.  
 
Click on the “drop-down” 
next to “Region”. 
 
  
 
 
 
 
 
 
 
 
 
 
No changes must be made, select Cancel. 

 

 
5) The field “Region #” has no changes. 
 
6) The field “State” has no changes. 

 
7) The field “Article” has to be renamed “Product” and we must verify that all the 

names have been entered correctly. 
 

  



CSA Power BI Append  the Second Stream  Mark Friedman 
  University of Miami 

 35  
 

Double click on “Article”, type “Product” and press the enter key. 
In the original Excel file, The Cuddly Stuffed Animals company provided the only 
acceptable values for “Product”.  
 
 
 
 
 
 
 
 
 
Click on the “drop-down” next to “Product”. 
 
 
The “Product” field can only contain one of the six products.  Browse the data in the 
“Product” field to verify that all the data is correct.  Make any changes that are required. 
 
 
 
 
 
“Pink Giraffe” must be replaced with 
“Giraffe”.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select Cancel.  
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With the field “Product” highlighted, select “Replace Values”. 
 
 
 
 
 
 
Value to find “Pink Giraffe”. 
Replace with “Giraffe”. 
 
 
 
 
 
Select OK. 
 
To confirm, click on the “drop-down” next to 
“Product”. 
 
 
 
 
 
 
 
 
 
 
Select Cancel.  
 
 

8) The field “# of units” has no changes. 
 
 

 
 
 

9)  The field “Selling Price Per Unit” does not exist in the “January Sales Data” 
stream of data.  Instead, there is a field “Sales”, the product of the “# of units” and 
the “Selling Price Per Unit”. 
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Operation 17: Create Calculated Field 
 
Select “Custom Column” from the “General” data group under the “Add Column” tab. 
 

 
 
 
 
 
 
 
 
 

 
New column name, “Sales”. 
 
 
 
Select “# of units” from the 
available list, double click or hit 
insert. 
 
Type, “*” select “Selling Price 
Per Unit” from the available list 
double click or hit insert. 
 
 
 

 
 
Select OK. 
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The type of field must be changed to a decimal. Click on 
the  in the left-hand corner of the field “Sales”. 
 
Select “$ Fixed decimal number”. 
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10) The field “Profit Margin” must be changed to a decimal 
Click on the  in the left-hand corner of the field “Profit Margin”. 
 
Select “$ Fixed decimal number”. 
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Operation 18: Append the Two Streams 

 

Select “Append Queries” from the “Combine” group under the “Home” tab. 

 

 
Select “Append Queries”. 

 

Select “Append Queries as New”. 

 
 

 

In the pop-up select 
“January Sales Data” as the 
“First table”. 

 

Select “February-December 
Sales data” as the “Second 
table”. 

 

Click “OK”. 
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This results in a new query named “Append1”. 

 

 

 

 

Operation 19: Load Data.  

 

Click on “Close and Apply” 

This loads the data onto Power BI from Power Query 
Editor. 

 

 

Now you’ll be back to the main window of Power BI. 

  
 

 

Make sure you add a new page.  
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Operation 19: Create a “Table”. 
Click on the Table icon under the Visualization section to add a table. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the   to the left of Append 1 to expand the fields. 
 
 
The order that you select the fields is used to determine the order 
in which the fields are displayed in the table. Click on the box next 
to each field in the order that you want the fields to be displayed.  

1. Product 
2. # of units 
3. Sales 
4. Profit Margin 

 
Size the table 
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Operation 20: Exporting data to Excel 
Select the table you want to export and notice that you get More Options indicated by 3 
dots (…) on the top or bottom right of the table.  

 

 

 

 

 

 

 

Click on the More Options.  

 

Select “Export Data”. 

 

 

 

 

Select the name of the file “Report by Product.csv”. 

 

 

 

 

 

 

Select Save  

 

Confirm the save. 

 

Open the original excel file  
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Select the file. 
 
 
 
 
Select “Open”. 
 
 
 
 
 

Navigate in file manager and double click on the “Report by Product.csv” file.  

 

 

 

 

 

 

 

 

 

 

 

Copy this tab to the original Excel by right clicking on the tab 
Report by Product and selecting “Move or Copy”.  

 

 

 

  



CSA Power BI Append  the Second Stream  Mark Friedman 
  University of Miami 

 45  
 

Select the name of the original file.  

 

 

 

 

 

 

 

 

 

 

Scroll till the end and click on 
“(move to end)”. 

 

Then click “OK”.  

 

Rename the tab as “Annual Report by Product”, format the sheet, save, and close the 
Excel file. 
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Operation 21: Save the “Flow and Data”  

Select “File”. 

 

Select the name of the file. 

 

 

Select Save. 

Close Power BI. 

 


